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Introduction
®

This document describes the procedures for licensing the InduSoft Web Studio (IWS) and CEView products.
®
®
InduSoft Web Studio runs on Microsoft Windows NT/2000/XP (WinNT/2K/XP), and is the workbench software
®
(development station) used to configure and debug applications for Windows NT /2000/XP or Windows CE (WinCE).
In addition, IWS is the runtime software for WinNT/2K/XP and CEView is the runtime software for WinCE.
The information provided in this document is valid for InduSoft Web Studio v5.1 or later.

 Note: InduSoft provides CEView for most platforms supported by the WinCE operating system. The CEView runtime
files for each platform are stored in the development station during the installation of InduSoft Web Studio. You can
use the remote management tools in IWS to download CEView runtime files to the WinCE device. See the InduSoft
Web Studio User Guide and Technical Reference for detailed information about these two products.
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Product Versions
InduSoft Web Studio and CEView share the same version number, according to the following syntax:
X.Y+SPWW
For example:
 InduSoft Web Studio v5.0+SP1


CEView v5.0+SP1

Where:


X: Represents the Family version. The Family version changes only when there are major enhancements in the
product’s technologies/concepts.



Y: Represents the Sub-version: The Sub-version changes when there are minor enhancements and/or new features
in the product.



WW: Represents the Service Pack. The Service Pack changes when add-on packages must be installed to
accomplish the following:


Upgrade files for the version previously installed



Fix bugs in the product (showstoppers and no-workarounds)



Provide minor enhancements before releasing the next version of the product

Each Service Pack release supersedes the previous Service Pack release. For example, SP2 includes all the
contents of SP1 and all newly upgraded files, bug fixes, and enhancements. SP3 includes all the contents of SP2
and all new upgraded files, bug fixes, and enhancements and so on.
 Caution: Both InduSoft Web Studio and CEView can execute applications built in previous versions of the
product. However, older versions of IWS and CEView cannot execute applications built or modified in newer
versions of the product.
 Important: Each license is issued for a specific Family version and Sub-version (X.Y), and is valid only for that
version (including its Service Packs). However, a license is not valid for a newer Family version or Sub-version
of the product. When you install a new version of InduSoft Web Studio or CEView, you must upgrade your
current license to the new version being installed. If you are installing a Service Pack only, you are not
required to upgrade your license.
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Execution Modes
InduSoft Web Studio and CEView support the following Execution Modes:
Execution Mode

InduSoft Web Studio

CEView

Evaluation Mode





Demo Mode





Licensed for Engineering Only





Licensed for Runtime Only





Licensed for Engineering + Runtime





 = Apply;  = Does NOT Apply



Evaluation Mode: Enables all features of the product (engineering and runtime).
When you install InduSoft Web Studio for the first time on a computer, the product runs for 40 (forty) hours in
Evaluation Mode. This evaluation period (40 hours) includes any time in which you are running any product
module (engineering or runtime). You can use this evaluation period continuously or not (for example: 10 hours a
day for 4 days, 5 hours a day for 8 days, 10 hours a day for 3 days plus 5 hours a day for 2 days, and so on).
After running the product for 40 hours, the Evaluation Mode terminates and IWS automatically activates the Demo
Mode until you install a valid license (Hardkey or Softkey). You cannot reactivate Evaluation mode—even if you
uninstall, and then reinstall the product on your computer.

 Note: Each version of the product has its own Evaluation Mode period, which is independent of every other
InduSoft Web Studio version. For example, if you have IWS version 5.1 installed on your computer and
running in Demo Mode (see following description) because your Evaluation Mode period expired (and you
have not installed a license). If you install IWS version 5.2 on the same computer, the 5.2 version will begin its
own Evaluation Mode period (40 hours) and the 5.1 version IWS will continue running in Demo Mode only.


Demo Mode: Enables you to download or upload applications to remote stations, and to run applications for testing
and/or demonstration purposes. You can execute runtime tasks and use the debugging tools (LogWin and
Database Spy), but they are shut down automatically after running continuously for two hours. You can restart the
Demo Mode again and run for another two hours, and so on. You cannot create or modify screens, worksheets, or
application settings in Demo Mode.
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The following menu options are available in Demo Mode:


File menu: Open Project and Exit options



View menu: Toolbars, Status Bar, Zoom, and Library options



Project menu: Settings, Status, Run Application, Stop Application, Send Project to Target, Execution Environment, and
Logon options



Tools menu: Register Controls, Convert Resolution, Verify Application, and System Information options



Help menu: [All Options]

 Note: If the Evaluation Mode period expires, and you do not install a valid license on your computer
(for example, your license was issued for an older version of IWS), IWS will run in Demo Mode only.


Licensed for Engineering Only: Enables all workbench options for an unlimited time. This mode also allows you to
execute the runtime tasks and debugging tools (LogWin and Database Spy) for 72 hours continuously. After the
72-hour period expires, these tasks shut down, but you can restart them again and run for another 72 hours, and
so on. You can use this license for development and testing only.



Licensed for Runtime Only: Allows you to run all runtime and debugging tools (LogWin and Database Spy) for
unlimited time, but you cannot create or modify screens and/or worksheets. The following menu options are
available in Runtime Only mode:





File menu: Open Project and Exit options



View menu: Toolbars, Status Bar, Zoom, and Library options



Project menu: Settings, Status, Run Application, Stop Application, Send Project to Target, Execution Environment, and
Logon options



Tools menu: Register Controls, Convert Resolution, Verify Application, and System Information options



Help menu: [All Options]

Licensed for Engineering + Runtime: Enables all engineering tools, runtime tasks, and debugging tools (LogWin and
Database Spy) for an unlimited period of time.
 Important: In addition to the Execution Mode, each license sets other restrictions, such as the Product Types
supported for the license. See the Product Type section for more information.

 Note: The Execution Environment tools are always available regardless of Execution Mode, which means you
can always use IWS to upload or download files from and to remote stations (such as remote WinCE devices)
using the Execution Environment dialog (Project → Execution Environment).
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To see which Execution mode you are running, select Help → About from the IWS interface main menu bar.
The About InduSoft Web Studio window opens and provides information about the current Execution Mode.
If you are running in Evaluation Mode, the Execution Mode field displays how much evaluation time remains (see the
following figure).
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Protection Types
InduSoft Web Studio and CEView support the following Protection Types:
Protection Type

InduSoft Web Studio

CEView

Hardkey (LPT1 or USB interface)





Softkey





 = Apply;  = Does NOT Apply



Hardkey: The Hardkey is an encapsulated chip that must be physically connected to the parallel port (LPT1) of the
local computer on which InduSoft Web Studio is installed. Optionally, IWS v6.0 (or higher) supports USB Hardkeys
as well.
Each Hardkey provides one license, which cannot be shared simultaneously with more than one copy of IWS in
the network. Using a Hardkey for the LPT1 port of your computer does not prohibit you from connecting any device
to the parallel port of the computer (for example a printer)—it should be electronically transparent to the devices
connected to the parallel port. For example, you can connect a printer cable to the Hardkey while the Hardkey is
connected to the computer. However, you may encounter problems if you install more than one Hardkey (for
different products) on the same parallel port. The IWS license resides in the Hardkey; therefore, if you connect the
Hardkey to another computer, you are transferring the license to this other computer. When using the Hardkey for
USB interface, the USB port where you connect the Hardkey cannot be used to connect any other device
simultaneously.
 Caution: You must use caution when installing or removing the Hardkey from the parallel port of the computer.
We strongly recommend that you turn off the computer and disconnect it from the power supply before
installing or removing a Hardkey.



Softkey: When you install InduSoft Web Studio (or CEView), the program generates a unique code (Site Code).
You must send this Site Code to your software vendor, who will then generate a license code (Site Key) to match
your Site Code. The Site Key installs the license on your computer (or WinCE device).

 Note: When using a Softkey, the license is recorded in the non-volatile memory of the computer (or WinCE
device) where you installed the product. If this device is damaged, the license is lost.
 Caution: The Softkey license is based on some unique information from your computer (or WinCE device).
Therefore, if you remove any hardware adapter from your computer (e.g.: HardDisk, Network adapter, and so
forth), your license may be lost. It is strongly recommended moving the Softkey license to another location
before modifying the hardware configuration from your computer. Consult your software vendor for further
information.
 Caution: Softkey licenses for IWSv6.0+SP1 (or newer) is not supported under Windows NT operating system.
When running IWSv6.0+SP1 (or newer) under Windows NT, it is required to use Hardkey instead of Softkey.
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License Settings
Each license sets the following parameters:
 Product Type: Specifies which features and restrictions are enabled for the application (such as maximum number
of tags supported, maximum number of drivers running simultaneously, and so on). Consult your software vendor
about which Product Types are available and which features are enabled for each type.
 Execution Mode: Specifies the following three options





Engineering Only: Configures and runs the application for testing during development only. You cannot use this
license as a long-term, run-time license.



Runtime Only: Runs the application for unlimited time. You cannot use this license to develop or modify the
application.



Engineering + Runtime: Configures, modifies, and runs the application for unlimited time.

Number of Web Thin Clients supported simultaneously by the Server: Specifies how many Web Thin Clients are
supported. You can connect one or more Web Thin Clients to the server simultaneously (for an additional charge),
but the license installed on the server must support these additional Web Thin Clients.
Options for adding Web Thin Clients are as follows:


Server for InduSoft Web Studio (WinNT/2000/XP): Connects 0 (No Web Thin Clients), 1, 2, 4, 8, 16, 32, 64, 128,
or 256 Web Thin Clients to the server simultaneously.



Server for CEView (WinCE): Connects 0 (No Web Thin Clients), 1, 2, 4, or 8 Web Thin Clients to the server
simultaneously.



Version Supported: When you generate a license, the license will specify the product version it supports.



Duration: When generating Softkeys, the license can be issued for a limited period of time (from 1 up to 99 days),
since the day when the license was installed. When this period of time expires, the license is no longer valid and
the product runs in Demo Mode until a new valid license is installed. The duration option is NOT available for
Hardkey licenses.
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Installing Hardkey Licenses for InduSoft Web Studio
This section explains how to install and upgrade Hardkey licenses for IWS (for Win NT/2000/XP).

Installing a New License
To install a new IWS license, use the following steps:
1. Install InduSoft Web Studio on your computer.
2. Connect the Hardkey to the parallel port (LPT1) or to the USB interface from the computer where you installed IWS.
 Caution: Use caution when installing or removing a Hardkey from your computer’s parallel port.
We strongly recommend that you turn off the computer and disconnect it from the power supply before
installing or removing the Hardkey.
3. Run InduSoft Web Studio.
Upgrading the Current License
To upgrade your current IWS license, perform the following steps:
1. Close all InduSoft Web Studio development and runtime modules.
2. Ensure the Hardkey is connected to the parallel port (LPT1) or to the USB interface from the computer where you
installed IWS.
3. Execute the Register module by selecting Start → Programs → InduSoft Web Studio →
Register.
4. When the Protection Manager dialog displays (see figure), click (enable) the Hardkey radio button in the Protection
Type section and click the Check button.
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If a valid Hardkey is not connected to the computer’s parallel port (LPT1) or to the USB interface, the following
error message displays:



If a valid Hardkey is connected to the computer’s parallel port (LPT1) or to the USB interface, the Register
module opens the Hardkey Settings dialog (see the following figure), which displays the current license
settings recorded on the Hardkey.

5. Click the Change License button on the Hardkey Settings dialog.

6. When the Change License – Hardkey dialog displays, copy the code information from the Site Code text box and
send it to your software vendor.
7. Your software vendor should send back a Site Key that matches the Site Code. Type this Site Key into the Site Key
field of the Change License – Hardkey dialog and then click the Authorize button.

Page 10/23

Technical Note – InduSoft Web Studio and CEView Licensing
January, 6 2006 – Rev. G
©Copyright InduSoft Systems Ltd. 2002-2006
You will be prompted to confirm the operation. If the program accepts (validates) your Site Key, the following
message displays:

 Note: If your new Site Key is not valid, an error message displays. If this happens, double-check that you
entered the Site Key correctly. If you entered the key correctly and still receive an error message, contact
your software vendor for assistance.
You can upgrade any license setting (Product Type, Execution Mode, or Number of Web Thin Clients)
simultaneously supported by the server, or upgrade the software version that is being supported currently. The
upgrade cost will depend on your current license settings and the settings of the upgrade license.
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Installing a SoftKey License for InduSoft Web Studio
This section explains how to install and upgrade a SoftKey license for IWS (on Win NT/2000/XP).

Installing a New License
To install a new SoftKey license for IWS, use the following steps:
1. Install InduSoft Web Studio on your computer.
2. Execute the Register module by selecting Start → Programs → InduSoft Web Studio →

Register.

3. Click (enable) the Softkey radio button in the Protection Type group, and then click the Check button.

The Softkey Settings dialog displays.


If you have not previously installed a license on your computer, the Status text box displays a License not
found message (as shown in the following figure).



If you already have a valid InduSoft Web Studio Softkey license installed, the current license settings display.

4. Click the Change License button on the Softkey Settings dialog.
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5. When the Change License – Softkey dialog displays, copy the code information from the Site Code text box and
send it to your software vendor.

6. Your software vendor will send back a Site Key that matches this Site Code. Type the Site Key into the Site Key
field of the Change License – Softkey dialog and then click the Authorize button.
You will be prompted to confirm the operation. If the program accepts (validates) your Site Key, the following
message displays:

 Note: If your new Site Key is not valid, an error message displays. If this happens, double-check that you
entered the Site Key correctly. If you entered the key correctly and still receive an error message, contact
your software vendor for assistance.
7. Close the Register module and run InduSoft Web Studio.
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Upgrading the Current License
To upgrade your current IWS license, use the following steps:
1. Before upgrading a Softkey license, you must re-install InduSoft Web Studio on the same computer where you
installed the previous license.
 Caution: Do not uninstall InduSoft Web Studio before getting an upgraded license from your software vendor
or you will lose your current license and it will not be possible to upgrade. (You will have to order a new
license.)
2. From the newly installed version of InduSoft Web Studio, open the \BIN subfolder and run the SKEYUPG.EXE
program.
The Upgrade Softkey dialog displays:

3. In the Upgrade Softkey dialog, click the … button. When the dialog displays, select the path (location) where the
previous (already licensed) version of IWS was installed, and close the dialog. The specified path information
automatically displays in the Path text box in the Old Version section.

4. Click the Save SKEYUPG.BIN file button to save the information necessary to generate the upgraded license.
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5. Copy the SKEYUPG.BIN file from the directory where you executed the SKEYUPG.EXE program and send it to
your software vendor.
6. Your software vendor will send you a Site Key matching the information saved in the SKEYUPG.BIN file.
7. Execute the Register module ( Register) for the newly installed version of InduSoft Web Studio (where you
executed the SKEYUPG.EXE program to generate the SKEYUPG.BIN file).
8. When the Protection Manager dialog displays (see the following figure), click (enable) the Softkey button in the
Protection Type section and click the Check button.

The Softkey Settings dialog displays.


If you have not previously installed a license on your computer, the Status text box displays a License not
found message (as shown in the following figure).
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If you already have a valid InduSoft Web Studio Softkey license installed, the current license settings display.

You can upgrade any license setting (Product Type, Execution Mode, or Number of Web Thin Clients)
simultaneously supported by the server, or upgrade which software version is being supported. The upgrade cost
will depend on your current license settings and the settings of the upgrade license.
9. In the Softkey Settings dialog, click the Change License button to open the Change License – Softkey.

10. Type the Site Key sent by your software vendor into the Site Key field of the Change License – Softkey dialog.
11. Click the Authorize button.
If the Site Key is accepted (validated), the following message displays:

 Note: If the new Site Key is not valid, an error message displays. If this happens, verify that you entered
the Site Key correctly. If you typed the Site Key correctly and still receive an error message, contact your
software vendor for further assistance.
12. Close the Register module and run InduSoft Web Studio.

Page 16/23

Technical Note – InduSoft Web Studio and CEView Licensing
January, 6 2006 – Rev. G
©Copyright InduSoft Systems Ltd. 2002-2006

Installing a SoftKey License for CEView


There are two ways to register a CEView license on your WinCE device:
Locally: Using the Remote Agent from the WinCE device as the interface.



Remotely: Using InduSoft Web Studio to send the license to the WinCE device.

 Note: You can purchase some WinCE devices with the CEView license already loaded. Consult your software
vendor about this possibility.
Installing or Upgrading a License (Locally)
To install a new (or upgrade an existing) CEView SoftKey license (locally), use the following procedure:
1. Download the Remote Agent program (CESERVER.EXE) into the \<Non-Volatile Folder> path of the WinCE
device. The \<Non-Volatile Folder> must retain this data after you reboot the WinCE device.

 Note: The \<Non-Volatile Folder> path can vary with each WinCE device manufacturer.
After installing IWS on the WinNT/2000/XP computer, the Remote Agent program file (CESERVER.EXE) is stored
in the following path:
<InduSoft Web Studio Path>\Redist\<WinCE version>\<Platform>\BIN\CESERVER.EXE
Where:


<InduSoft Web Studio Path> is the directory where you installed IWS (for example,
C:\Program Files\InduSoft Web Studio\).



<WinCE version> indicates the operating system version (for example, CEView for Windows CE v3.0,
WinCE 4.0 for Windows CE v4.0, WinCE 4.1 for Windows CE v4.1, and so forth).



<Platform> is the WinCE device processor type (for example, x86).

 Note: In some WinCE devices, the \<Non-Volatile Folder> points to a FlashCard memory that is
connected to the device. Also, before downloading the Remote Agent (CESERVER.EXE) to your WinCE device,
be sure it is not already loaded in the \<Non-Volatile Folder>.

Tip: There are several ways to download the Remote Agent program (CESERVER.EXE) to a WinCE device.
®

 You can use the Microsoft ActiveSync utility to download/upload files from a WinNT/2000/XP station to a
WinCE device. You can download ActiveSync from the Microsoft Web site at no charge.
 You can use the following command syntax to map a shared folder from a WinNT/2000/XP computer to
most WinCE devices:
net use [<Local Name>] [Remote Name] [/user:<UserName>]
After executing this command successfully, open a Command Prompt window and use a COPY command to copy
files to the WinCE device.
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Tip: We strongly recommend that you configure the WinCE device to execute the Remote Agent program
automatically when you power on the WinCE device. See the WinCE device manufacturer’s documentation for
information about how to configure the Startup program on the device.
2. If the Remote Agent program (CESERVER.EXE) does not start automatically when you power on the WinCE
device, you can run it manually from the \<Non-Volatile Folder>.

3. From the Remote Agent dialog, click the Setup button to open the Setup dialog (see following figure).
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4. On the Setup dialog, click the License button to open the License dialog:

5. Click the Change License button to open the Change License dialog:

6. Copy the site code information (provided in the Site Code text box) and send it to your software vendor.
7. Your software vendor will send back a Site Key that matches this Site Code. Type the Site Key into the Site Key
field on the Change License dialog, and click the Authorize button.
If the Site Key is accepted (validated), the following message displays:

 Note: If the new Site Key is not validated, an error message displays. If this happens, double-check that you
entered the Site Key correctly. If you typed the key correctly and get an error message, contact your software
vendor for further assistance.
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Installing or Upgrading a License (Remotely)
To install a new (or upgrade an existing) CEView SoftKey license (remotely), use the following procedure:
1. Execute the three first steps described in the previous section.
2. In the Setup dialog, specify the Device Connection type by clicking (enabling) the Serial Port or TCP/IP radio button. (If
you enable Serial Port, you also must select a port from the combo-box list). Click OK to close the dialog.
3. Run InduSoft Web Studio on the WinNT/2000/XP station and connect this station to the WinCE device using either
a serial or TCP/IP link.
4. From the IWS main menu bar, select Project → Execution Environment to open the Execution Environment dialog
(as shown in the following figure).

5. Specify a target station by clicking one of the following radio buttons in the Target Station:
 Local
 Network IP and type the IP address into the field provided
 Serial Port and select a port from the combo-box list provided
6. When the Connect button becomes active, click the button to connect to the WinCE device on which the Remote
Agent is running. (If you select Network IP, you must also enter the IP address in the text box provided.)

Tip: TCP/IP links provide better communication performance than Serial links.
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The Status field must display the following message:
Connected to CEView <CEView Version>

7. Select the CE License tab to see which license settings are currently installed on your WinCE device.

8. From the License Codes section of the Execution Environment dialog, copy the information from the
Site Code field and send it to your software vendor.
9. Your software vendor will send you a Site Key that matches this Site Code. Type this Site Key into the
Site Key field.
10. Click the Send button to send the code to the Remote Agent running on the WinCE device.
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The Remote Agent program will attempt to install the new license using the Site Key sent from InduSoft Web
Studio. If the Site Key is accepted (validated), the following message displays:

 Note: If the new Site Key is not valid, an error message will display. If this happens, double-check that you
typed the Site Key correctly. If you entered the Site Key correctly and still receive an error message, contact
your software vendor for further assistance.
 Caution: After sending the license to the WinCE device, be sure to save its registry settings. If you do not
save these settings, you will lose the license after rebooting the device.
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